Server 2003 Checklist- Created by Charlie Franks

This checklist is somewhat similar to the Windows 7 checklist, however many
tools that exist in Windows 7 don’t exist in Windows 2003 server, or are in
different locations. Follow this guide for Windows 2003 Server. | created this
checklist with a Windows Server 2003 image that was in Portuguese, so the
translations may not be 100% correct, just try your best... Sorry for the
inconvenience. | didn’t have time to create a Table of Contents, hopefully
someone can add that in later. It’s in a similar order to the Win7 checklist, just
follow the steps and you should get anywhere from a 70-100%, anywhere in there
should get you set for Round 2. | know | have not included DNS and DHCP guides, |
didn’t have enough time with the 2008-2003 switch. It’s the best | can do, sorry.
I’ve been working like a dog for the past few days to get it ready, and there just
wasn’t enough time to get it done. There are other guides out there that can help
you secure them.
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<+ Before you start
» Assign half of your total RAM for your VM
Research machines are prepped and ready
Host machine
At least 2 backup machines ready to go (VM’s unzipped, but NOT started up)
VMware Tools installed
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Access to the Google Drive

Now, start up the image

THE FIRST THING YOU NEED TO DO IS CHECK TO SEE IF MALWAREBYTES/CCLENAER OR SOMETHING LIKE
THAT IS INSTALLED. IF IT IS, UNINSTALL IT IMMEDIATELY, DO NOT USE IT. FOR INSTRUCTIONS ON HOW
TO UNINSTALL, SEE NUMBER 4

1. Clear the DNS Cache
a. Open up a command prompt by clicking the Start button and typing cmd
b. Select the cmd.exe icon, and the command prompt window should open up
c. Type ipconfig /flushdns

2. Enable Viewing of Hidden Files
a. Go to My Computer, then go to Tools. Select Folder Options

Go to the View tab

Select the Show hidden files and folders

Uncheck the Hide extensions for known

Uncheck the Hide protected OS files

Uncheck the Hide empty drives...
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3. Install MalwareBytes and Process Explorer, and Run MalwareBytes
a. First, go to the google doc’s site. In case you don’t have it, or are too lazy to look it up,
here is the link to the google docs page- https://drive.google.com/#folders/0B7FKJ-
QDh83GQUFYeDd6cESIMWSE



https://drive.google.com/#folders/0B7FKJ-QDh83GQUFYeDd6cE9lMW8
https://drive.google.com/#folders/0B7FKJ-QDh83GQUFYeDd6cE9lMW8

i. To download something, Right Click it and click Download
b. Now, go to the Malware folder, then download MalwareBytes Installer.exe
We also need Process Explorer. Go to the Processes folder, and download Procexp.exe
On MalwareBytes, when it gives you the option to update, do it
i. It may say the installer is out of date, just go along with it. Download and install
the newer install version, then Install it.
e. When it finishes installing, uncheck the Enable Malwarebytes PRO edition or whatever
itis, we don’t need that.
Select the Full Scan, then click Scan
g. Scan the Cdrive only

Whiles the Malwarebytes is running, we have to do other stuff, so come back to step g when
malwarebytes is done scanning

h. When the scan finishes, select the Show Results button, and then make sure each box is
selected, and click remove selected.

4. Stop Network Shares
Open the Start menu, and type in cmd
Do not hit enter. Right click, and choose Run as Administrator

Now, if User account control menu pops up, click yes
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Type in net share
i. This lists all the active shares from your computer, we are going to kill these
now
e. Type net share /delete INSERT NAME OF NET SHARE HERE
i. Ifthe name includes a $, that means the share is hidden. Yes you should still
delete it, and you have to include the dollar sign in the name to delete it
f. Delete every share that is listed
i. IPCS will be restarted on boot up, this can’t be changed, and won’t be counted
for points ever anyways. The other two default shares are CS and ADMINS
5. Adding or Removing Server Roles
a. First, read the readme and note down the server roles the server requires
Click on Start, then click on Server Manager
Click on Add or Remove a Role
Click Next
Select the Server Role you want to remove, then click Next
Check the bottom check box that says Remove the ______server role
Click Next, let it remove the server roles
Click Finish
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6. Firewall
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Windows Sever 2003 has a much more basic firewall than Windows 7, its relatively easy
to configure

Click Start, then open the Control Panel.

Click on Windows Firewall

Turn the Firewall On, but DO NOT CHECK THE “No exceptions” button

Go to the Exceptions tab

The only exception in there should be Scoring bot or Cyberpatriot

i. If anything is in there like netcat or nc or file sharing, uncheck them
Go to the Advanced tab
Click on the Security Log Configuration button
i. Check both boxes at the top
ii. Increase the Log size limit to 20000 KB
iii. Click OK
Click OK

7. Remote Desktop

a.
b
c.
d.
e

f.

Right click My Computer and go to Properties

Go to the Remote tab

Go to the Advanced button

Uncheck Allow this computer to be controlled...

Now, uncheck Allow remote assistance connections...
Apply, and ok

8. Power Settings

a.
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Go to the Control Panel and go to Power Options
Change the Turn off Monitor to 5 minutes
Change the Turn off the hard disk to 30 minutes
Go to the Advanced tab

Select the Require a Password on Wakeup

Click Apply, then OK

9. Delete Rogue Users

a.

These steps are running under the assumption you are using Active Directory Users and

Groups. To find out how to secure Local Users and Groups, look at the Windows 7

Checklist and follow those steps.
Go to Start, type MMC, hit enter
Now, go to File, Add/Remove Snap-ins, scroll down and choose Active Directory Users

and Groups
Find the users that do not matchup with those in the readme, or default users
i. Default users are Administrator, and Guest
Make sure, check again
Now delete them. Right click the desired user, and click Delete. If a prompt comes up
that says do you want to delete the user’s files? Click Yes.



g. We need to rename the guest account (and possibly the Administrator, see below)
i. Check to see if you are working on the default administrator account. Click
Start, then on the top right, your username should be displayed. If you are using
the default Administrator, do NOT change his name. If you are not, rename the
Administrator account
h. Right click the desired user, and click Rename. Don’t make it guessable, like your name
or something. Make it completely random

i. We also need to disable the Guest account. Right click that account, and click Disable
jo Set a password for the remaining user accounts you did not delete
i. Make this password 8 characters, with 1 number and 1 special letter |@#S%"
etc.
10. Services
a. Before you touch anything with services, make sure you read the readme. If it says you

need SMTP running, or SNMP, or Remote Desktop, follow the readme, do not disable

ANY of those services, if the readme says so.
Open up services by clicking Start, then typing MMC. Click the MMC icon
Now, click File, then Add/Remove Snap-in.
Add in the Services Snap-in, then click finish and ok
Sort by name, and cross reference with the default services. If you find a service not on
this list and are unsure about it, just google it, or follow the steps below
i. DO NOT DELETE ANYTHING TO DO WITH CP, CYBERPATRIOT, SCORING BOT,
SAIC etc. Do not even touch them.
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ii. For other services, Right Click, go to Properties, and check the Path to
Executable. It should be on the default page.

iii. Find the executable file, by putting the location into the Start menu, but make
sure you don’t accidently run it!

iv. Check the date it was installed, and cross reference the date of installation for
Windows 2003 server. If you are still unsure, just google the name of the
executable. You will know it is an executable file, because it will end with .exe

f. Default services that are not necessary. IF THE README SAYS OTHERWISE GO BY THE
README
g. Here are the Default Services, and their recommended settings for a Windows 7 box-

Required Configuration (CHANGE TO THIS

Service Name ONE!!)
ActiveX Installer Disabled
Adaptive Brightness Disabled
Application Experience Manual
Application Identity Manual

Application Information Manual



Application Layer Gateway Service
Background Intelligent Transfer Service
Base Filtering Engine

BitLocker Drive Encryption Service
Bitlock Level Backup Engine Service
Bluetooth Support Service

Certificate Propagation

CNG Key Isolation

COM+ Event System

COM+ System Application

Computer Browser

Credential Manger

Cryptographic Services

DCOM Server Process Launcher
Desktop Window Manager Session Manager
DHCP Client

Diagnostic Policy Service

Diagnostic Service Host

Diagnostic System Host

Disk Defragmenter

Distributed Link Tracking Client
Distributed Transaction Coordinator
DNS Client

Encrypting File System

Extensible Authentication Protocol

Fax

Function Discovery Provider Host
Function Discovery Resource Publication
Group Policy Client

Health Key and Certificate Management
HomeGroup Listener

HomeGroup Listener

Human Interface Device Access

IKE and AuthlIP IPsec Keying modules
Interactive Services Detection

Internet Connection Sharing

IP Helper

IPsec Policy Agent

KtmRm for Distributed Transaction Coordinator
Link-Layer Topology Discovery Mapper
Microsoft .NET Framework NGEN v2.0
Microsoft iSCSI Initiator Service
Microsoft Software Shadow Copy Provider
Multimedia Class Scheduler

Net.Tcp Port Sharing Service

Disabled
Manual
Automatic
Manual
Disabled
Disabled
Disabled
Manual
Manual
Manual
Manual
Manual
Automatic
Automatic
Automatic
Automatic
Disabled
Disabled
Disabled
Disabled
Manual
Manual
Automatic
Manual
Manual
Disabled
Manual
Manual
Automatic
Manual
Disabled
Disabled
Disabled
Manual
Disabled
Disabled
Manual
Manual
Disabled
Manual
Manual
Disabled
Disabled
Disabled
Disabled



Netlogon

Network Access Protection Agent
Network Connections

Network List Service

Network Location Awareness

Network Store Interface Service

Parental Controls

Peer Name resolution Protocol

Peer Networking Grouping

Peer Networking Identity Manager
Performance Logs & Alerts

Plug and Play

PnP-X IP Bus Enumerator

PNRP Machine Name Publication Service
Portable Device Enumerator Service
Power

Print Spooler

Problem Reports and Solutions Control Panel Support
Program Compatibility Assistant Service
Protected Storage

Quality Windows Audio Video Experience
Remote Access Auto Connection Manager
Remote Access Connection Manager
Remote Desktop Configuration

Remote Desktop Services

Remote Procedure Call (RPC)

Remote Procedure Call (RPC) Locator
Remote Registry

RIP Routing

Routing and Remote Access

RPC Endpoint Mapper

Secondary Logon

Secure Socket Tunneling Protocol Service
Security Accounts Manager

Security Center

Server

Shell Hardware Detection

Smart Card

Smart Card Removal Policy

SNMP Trap

Software Protection

SPP Notification Service

SSDP Discovery

Superfetch

System Event Notification Service

Disabled
Manual
Manual
Manual
Manual
Automatic
Disabled
Disabled
Disabled
Disabled
Manual
Disabled
Disabled
Disabled
Disabled
Automatic
Disabled
Manual
Manual
Manual
Disabled
Disabled
Disabled
Disabled
Disabled
Automatic
Manual

AN Dis-Disabled
Disabled
Automatic
Disabled
Disabled
Automatic
Automatic
Disabled
Disabled
Disabled
Disabled
Disabled
Automatic
Manual
Disabled
Manual
Automatic



Tablet PC Input Service

Task Scheduler

TCP/IP NetBIOS Helper
Telephony

Telnet

Themes

Thread Ordering Server

TP AutoConnect Service

TP VC Gateway Service

TPM Base Services

UPnP Device Host

User Profile Service

Virtual Disk

VMware Snapshot Provider
VMware Tools

Volume Shadow Copy

WebClient

Windows Audio

Windows Audio Endpoint Builder
Windows Backup

Windows Biometric Service
Windows CardSpace

Windows Color System

Windows Connect Now
Windows Defender

Windows Driver Foundation
Windows Error Reporting Service
Windows Event Collector
Windows Event Log

Windows Firewall

Windows Font Cache

Windows Image Acquisition
Windows Installer

Windows Management Instrumentation
Windows Media Player Network Sharing Service
Windows Modules Installer
Windows Presentation Foundation
Windows Remote Management
Windows Search

Widows Time

Windows Update

WinHTTP Web Proxy AutoDiscovery Service
Wired Autoconfig

WLAN AutoConfig

WMI Performance Adapter

Disabled
Disabled
Disabled
Disabled
Disabled
Manual
Manual
Disabled
Disabled
Disabled
Disabled
Automatic
Manual
Manual
Automatic
Disabled
Disabled
Disabled
Disabled
Manual
Disabled
Disabled
Disabled
Disabled
Automatic
Manual
Manual
Disabled
Automatic
Automatic
Disabled
Disabled
Manual
Automatic
Disabled
Manual
Disabled
Disabled
Automatic
Manual
Automatic
Disabled
Manual
Manual
Disabled



Workstation Automatic
WWAN AutoConfig Manual

The following are common, but not default Windows Services. Disable all of the following, unless the
readme says otherwise!

i. SMTP
ii. Bonjour
iii. Remote Access Auto Connection manager
iv. Remote Access Connection manager
v. Remote Desktop Config
vi. Remote Desktop services
vii. Remote Registry
viii. RIP routing
ix. World Wide Web Publishing service- This means you have IIS server running

Remember to check on MalwareBytes!!

11. Processes and Open Ports
a. Open ports are one of the most important things to check- because hard to find
programs will almost always open ports.
b. Open up a command prompt, and type netstat —ano
i. This will list the port number, the IP, and the PID
c. Now, we need Process Explorer
i. Go tothe Downloads folder, and click on Procexp.exe.
1. It will ask you to agree, just click Yes
d. Click on the Options menu, then select Verify Image Signatures. This will ensure that an
executable actually is made by who they say. They can fake the creator/signature.
e. Now, go to the View tab, and click on Select Columns. Make sure the following are
selected:
i. PID
ii. Company Name
iii. Verified Signature
iv. Image Path

Now, we need to figure out what Processes open which Ports
g. Cross reference the Open Ports’ PID with the PID’s from Process Explorer. These are
normal Default Windows Processes-
i. System Idle Process



ii. System
iii. Smss.exe
iv. Crss.exe
V. Services.exe
vi. Winnit.exe
vii. Searchindexer.exe
viii. Lsass.exe
iX. Winlogon.exe
x. Dwm.exe
xi. Svchost.exe (YOU NEED TO CHECK ALL OF THESE BECAUSE A LOT OF MALWARE
LIKES TO HIDE UNDER THIS PROCESS NAME!)
xii. Explorer.exe
Make sure you have cross referenced each the PID’s from the Command Prompt and
Process Explorer
If you are unsure if a process is malicious or not, look at the company name, and the
Verified Signature. If it is a SVChost with Microsoft Company name and it is verified,
then it is OK. However, we don’t want all products from Microsoft Corporation, such as
a Telnet Server, or SMTP server running (Unless the readme says so.) If you are unsure,
google it.
To end a malicious or unneeded process, the first thing you need to do is write down the
Path. This will be important later on
Now, we need to right click the process, and select Kill Process. This will stop the
Process from running.
However, our job is not done yet, we need to delete the .exe file that was running the
process. Take note that you do NOT need to do this for verified Microsoft Corporation
products, like Telnet or SMTP. However, make sure you have disabled the service

. Take the file path (I really, really hope you wrote it down...) and click Start and copy it in

to the search bar. Be careful not to accidently run the .exe file again.

We need to delete the file, so go into the folder containing the file, and hold down the
SHIFT + DELETE keys. This will permanently delete the file, instead of just sending it to
the recycle bin.

Triple check to make sure you want to delete it

Click Yes

Rinse and repeat until you have checked all of the Processes

12. Disable Write Debugging Information

b
c.
d

Right click My Computer and go to Properties
Go to the Advanced tab

Go to Startup and Recovery and go to Settings
Change Write Debugging Information to None



13. Remove Programs from Startup.

iv.

Go to Run (Windows Key + R)
Type msconfig
Go to the Startup tab

1. Only these should be listed:
a. Any type of VMware software
b. Malwarebytes if you installed it yourself
c. Anything Cyberpatriot or Scoring Bot related

2. We don’t need anything else.

3. Write down the name, and the location of the file. Then, follow the
Processes and Ports module to find out if it is malicious. If it’s
something like Netcat, bfk, nc, ncat, telnet, an alarm should go off in
your head. You need to uncheck these immediately

4. Disable the startup things you don’t need- See list above

This makes it so that the program doesn’t restart when we turn the computer
off and on again

14. Adding/Removing Windows Components
a. Check the readme to make sure you are removing things you do NOT need.

Open up a Control Panel

b

¢. Go to the Programs menu, then click on Programs and Features
d. On the left pane, select Turn Windows Features On or Off

e. Turn off these features, unless the readme says otherwise-

i.
ii.
iii.
iv.
V.
Vi.
Vii.

viii.

Xi.
Xii.
Xiii.

15. Policies

Games

Internet Information Services
Internet Information Services Hostable Web Core
Media Features

Print and Document Services
RIP

SNMP

Telnet Client

Telnet Server

TFTP Client/Server

Windows PowerShell

XPS Services

XPS Viewer

a. Open up the MMC
b. Add in the Group Policy Object Editor Snap-in



i. Ifthe computer doesn’t have GPOE, then you either need to update it, or it is
home basic, in which just skip this step. Although | doubt you will get a home
basic image.

c. Afew things to note- READ THESE BEFORE YOU START

i. Inthe policy list, I'm not going to include Network and Local Service. IF YOU SEE
THESE IN THE LIST, DO NOT REMOVE THEM

ii. DO NOT REMOVE THE CYBERPATRIOT SCORING BOT USER FROM ANYTHING

iii. Even if it says no one, DO NOT REMOVE NETWORK/LOCAL SERVICE FROM
ANYTHING

d. Configure the Policies as you see Below

Password Policy

Enforce Password History 8
Maximum Password Age 14
Minimum Password Age 8
Minimum Password Length 8
Password must meet... Enabled
Store Passwords using... Disabled

Account Lockout Policy

Account Lockout Duration 10
Account Lockout Threshold 7
Reset Account Lockout Counter... 10

User Rights Assignment

Access credential manager as a... Admin
Access this computer from the network No One
Act as part of the OS No One
Add workstation to domain No One
Adjust memory quotas for a process No One
Allow logon locally Admin
Allow logon through RDS No One
Backup files/directories Admin
Bypass traverse checking No One
Change the system time No One
Change the time zone No One
Create a page file No One
Create a token object Admin
Create global objects Admin
Create permanent shared objects No One

Create symbolic links Admin




Debug programs No One
Deny access to this computer... No One
Deny logon as a batch job No One
Deny logon as a service No One
Deny logon locally No One
Deny logon through RDS No One
Enable computer and User Accounts... Admin
Force shutdown from a remote system No One
Generate security audits No One
Impersonate a client after authentication No One
Increase a process working set No One
Increase scheduling priority Admin
Load and unload device drivers Admin
Lock pages in memory Admin
Logon as a batch job No One
Logon as a service No One
Manage auditing and Security log Admin
Modify an object label Admin
Modify firmware environment values Admin
Perform volume maintenance tasks Admin
Profile single process Admin
Profile system performance Admin
Remove computer from docking station Admin
Replace a process level token Admin
Restore files and directories Admin
Shutdown the system Admin
Synchronize directory service data Admin
Take Ownership of files... Admin

Security Options

Admin Account

If you are logged on as the default Admin, enabled.
If not, Disabled

Guest Account

Disabled

Limit Local use of Blank Passwords

Enabled

Rename Admin account

If you are logged on as the default Admin, do not
rename it If not, rename it

Rename Guest account Rename it
Audit the access of... Enabled
Audit the use of... Enabled
Force audit policy... Enabled
Shutdown the machine if unable to log

security audits Disabled
Machine access restrictions Not Defined




Machine launch restrictions

Not Defined

Allow undock without having to logon Disabled
Allowed to format and eject removable media | Admin only
Prevent users from installing printer drivers Enabled
Prevent CD-ROM access Enabled
Restrict floppy access Enabled
Allow server operators to schedule tasks Disabled
LDAP Server signing requirements Require it
Refuse machine account password changes Enabled
Digitally encrypt or sign secure channel data Enabled for all of them
Disable machine account password changes Enabled
Maximum machine password age 13 days
Require strong (Windows 2000 or later)

session key Enabled

Display user information when the session...

Do not Display user information

Do not display last user name

Enabled

Do not require CTRL + ALT + DEL Disabled
Message Text for users attempting to logon leave blank
Message Title for users attempting to logon leave blank
Number of previous logons to cache

Prompt user to change password before

expiration 8 days
Require domain controller authentication... Disabled
Require smart card Disabled
Smart card removal behavior No action
Digitally sign communications Disabled
Send unencrypted passwords to 3rd party

SMB servers Disabled
Amount of Idle time before suspending

session 45 minutes
Digitally sign communications Disabled
Disconnect clients when logon hour expires Disabled
Server SPN target name Leave it alone
Allow Anonymous SID/Name Translation Disabled
Do not allow anonymous enumeration of SAM

accounts Enabled
Do not allow anonymous enumeration of SAM

accounts and shares Enabled
Do not allow storage of passwords... Enabled
Let everyone permissions apply to anonymous

users Disabled
Name pipes that can be accessed

anonymously Disabled

Remotely accessible ANYTHING

Remove all text




Restrict anonymous access Enabled

Shares that can be accessed anonymously Delete everything
Sharing and security Classic

Allow local system to use... Disabled

Allow local system to null session fallback Leave alone

16. Uninstalling Internet Explorer

a.

c.
d.

Now technically, Windows 2003 server shouldn’t have Internet Explorer Installed, since

it'’s a Windows Server machine, so there wouldn’t be a reason to browse the web. So we

are going to uninstall it.
Go to the Control Panel, then go to Programs, then go to Add/Remove Windows
Components

i. 1 know this was covered earlier, I’'m just making sure you actually uninstalled
it.
Find Internet Explorer, and uncheck it
Now, click next and uninstall Internet Explorer

17. Power Settings

a.

b
c.
d.
e

Go to the Control Panel and go to System and Security
Go to the Power Options menu

Select the Require a Password on Wakeup

Select the Require a password

Save changes

18. Data Execution Prevention

a.

b
c.
d.
e

Go to the Control Panel, and go to the Top right corner. Change View by: to Small Icons
Then, look for the Performance Icon

Now, go to Adjust Visual Effects option

Navigate to the Data Execution Prevention tab

Select Turn on DEP for All Programs and Services Except those | Select (don’t put any in
there)

Apply and ok

19. 1IS Lockdown

a.
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A lot of this tool depends on the readme, and what it says you need. If you need SMTP

or something else, then make sure you don’t uninstall it.

Get the IIS Lockdown tool from the Google docs

Open the tool, and click Next

Click on the Other

Remove all of the checks that you do not need (Consult the readme), and click Next



f.

Uncheck the unneeded Script Maps, and click Next- For Example- If you don’t need
printing, uncheck internet printing

Check the lISAdmin, IIS Samples, MSADC, lISHelp, and Scripts. Check both Running
System Utilities and Writing to content directories. Check Disable Web Distributed
Authorizing, and Click Next

Click Next/Finish

I’'m not too sure how this tool will react with CyberPatriot, so be very careful when you
finish that you don’t uninstall something you need.

20. Alternate Data Streams (ADS)

a.

ADS is alternate data streams. It is a vulnerability in the way NTFS works, so files can
hide themselves. We have to get a scanner to remove it

Get the ADSspy from the google docs. It is on the Cyber Toolkit main page

Install ADSspy

Select Full Scan (all NTFS drives) so it scans the whole box. This will let you know what
streams come up, and you can remove them from there. You can skip ahead to the next
step while it is scanning the image.

21. Malicious Drivers

a.

Download the tool Uniblue DriverScanner (Its not on google docs :( you have to find it
yourself)

Install the tool

Scan the system- this will let you know if any drivers are out of date, and if there are any
malicious drivers on the system. Update them as recommended by the program

22. GMER scan

a.

b.

GMER scans for rootkits on the system which is great. Get it from the google docs, in the
Rootkits folder
Run the GMER scan, and remove any programs that it turns up

23. CCleaner

a.
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Get CCleaner installer from the Malware folder in google docs
Download and install CCleaner with the recommended settings

On the Intelligently Scan for Cookies to keep popup menu, click No
Click Analyze and let CCleaner run

Check all of the boxes it turns up, and click Run Cleaner

Now, go to the Registry Tab, and click Scan for Issues

Let it scan, then click all the boxes, and say Fix Selected Issues

Click Yes, and save the .reg file when it comes up

24. Microsoft Baseline Security Analyzer scan

a.

Get MBSA from the google docs, under the Malware folder



b. Install MBSA using recommended settings
c. Startup MBSA, and click Scan a Computer
d. Find out what MBSA says your image is not good with, and fix it

25. Installing an Anti-Virus
a. Download the AVG installer.exe from the google docs, in the Antivirus folder
b. Install AVG. Choose Basic Protection, and Custom Install
i. Uncheck each box from the custom install, we don’t want any of their bloatware
ii. Uncheck each box from the Component Selection
iii. Finish Installing it

DO NOT TURN OFF YOUR COMPUTER WHEN IT IS INSTALLING UPDATES. MAKE SURE YOU ARE PLUGGED
IN

26. Updating via Control Panel
a. Open up the Control Panel, and click System and Security
i. You may have the other version, just click Windows Update
ii. Under Windows Update, click Check for Updates.
iii. Install all of the required updates
27. Service Packs
a. Get the Services packs from the Google Docs, in the Service Packs folder. Make sure you
have selected the right operating system
b. Install the service pack by double clicking it and let it run.

The following are registry keys and advanced policies. Follow exactly what they say, or you will mess
up your image. Be extremely careful and triple check what you are doing

28. Advanced Policies
a. Open up an MMC, Add in the Group Policy Object Editor Snap-in, Go to Computer
Configuration, then go to Administrative Templates. | don’t know exactly where all of
these are located, and | don’t have time to look them up right now, the checklist
deadline is coming up fast. Try to find all of these, and apply them as such.

1. Prevent redirection of USB devices- Enabled

2. Allow Printers to be published- Disabled

3. Allow Print Spooler to Accept Client Connections- Disabled

4. Disallow Installation of Printers using Kernel-mode Drivers- Enabled
5. Prevent Metadata Retrieval from the Internet- Enabled



6. Enforce Disk Quota Limit- Enabled

7. Lock Enhanced Storage When the Computer is locked- Enabled

8. Enable NTFS Page file Encryption- Enabled

9. Require a Password when the Computer Wakes- Enabled

10. Detect Application Installers that need to be run as Admin- Enabled
12. Allow Users to Access Troubleshooting Content- Disabled

13. Allow Users to Access and Run Troubleshooting Wizards- Disabled
14. Prevent Access to 16-bit Applications- Enabled

15. Turn off auto play- Enabled

16. Prevent the User from Running Backup Status and Configuration Program- Enabled
17. Prevent Backing up to Network Location- Enabled

18. Prevent Backing up to Optical Media- Enabled

19. Prevent the Computer from Joining a Home group- Enabled

20. Disable Remote Desktop Sharing- Enabled

21. Prohibit New Task Creation- Enabled

22. Always Install with Elevated Privileges- Disabled

23. Prohibit User Installs- Enabled

24. Allow Remote Shell Access- Disabled

25. Disable Automatic Install of Internet Explorer Components- Enabled
26. Always Prompt Client for a Password on Connection- Enabled

27. Encryption levels- High (128 bit)

28. Password Protect the Screensaver- Enabled

Hopefully at this point you guys are set to go. If you feel nervous with an 80 or 90, try looking online for
tools like MBSA or nessus, and use them to scan your box and find vulnerabilities you may have missed.



